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About MicroHelp

You can get in touch with MicroHelp at the following address:

MicroHelp, Inc.
4359 Shallowford Industrial Parkway
Marietta, GA    30066

Sales: (800) 922-3383
Fax: (404) 516-1099
Technical support: (404) 516-0898
BBS: (404) 516-1877

Hours:    Monday through Friday, 9:00 AM to 5:00 PM, Eastern Time

See also:
About IniClean



About MicroHelp IniClean

MicroHelp IniClean
Version 1.0

By Ken Spreitzer
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All rights reserved

MicroHelp and IniClean are trademarks of MicroHelp, Inc.    Other names are trademarks or 
registered trademarks of their respective owners.

See also:
About MicroHelp



Association

An association is created to identify files (for example, those files with extension "TXT") with the 
application that created them (for example, "NOTEPAD").

If you try to "run" a document (for example, "TO-DO.TXT") by double-clicking on it in the Windows File 
Manager, Windows will automatically run the associated application ("NOTEPAD") and load the 
desired data file ("TO-DO.TXT").

A typical example of an association is to say that TXT is associated with Notepad.    This is association 
is saved in WIN.INI and is written as:    TXT = NOTEPAD.EXE ^.TXT.

IniClean allows you to view or delete associations.    Use Windows File Manager to edit associations.



Change directory

When you want to view or edit an INI file in a different directory, use this dialog box to select any file in 
the desired directory.    Once you have chosen any file in a directory, all INI files in that directory are 
available for editing.

To change directory:
1. If the "Choose any file in the desired directory" dialog box is not yet displayed, display it 

by choosing "Change directory" from the File menu of the main IniClean window.
2. Choose an available drive from the Drives list box.
3. Use the Directories list box to select the desired directory.    Remember to always 

double-click (or press ENTER) in the Directories list box!
If the directory which you have selected contains any INI files, they will be listed in the 
file list box.    If the directory does not contain any INI files, select another directory.

4. When you have located the directory containing the desired INI file, select the INI file 
and choose OK.

To close the dialog box without changing to another directory:
1. Choose the Cancel button.



Changing the "New since" date

When listing INI files, you can change the "New Since" date to force IniClean to list only those INI files 
which have been modified since a given date.

Note:
The "New since" option is only available in directories which contain a valid WIN.INI file, and is not 
available the first time that IniClean is run on each Windows directory.

To change the "New since" date:
1. Make sure that "Other INI files" is selected in the "Display" group box.
2. Select "New since" in the "Which ones?" group box.
3. Change the date in the edit field following the "New since" label.
4. Press ENTER to accept the new date.

Note:
You cannot change the "New since" date when listing associations or sections.



Command line options

IniClean can be started with any of the following command line formats:

Format: IniClean
This is the standard way of starting IniClean.    When started no command line options, IniClean will 
default to the user's Windows directory.

Format: IniClean    INI_file_spec
Example: IniClean    D:\WIN30\WIN.INI
Use this format to have IniClean switch to another directory instead of starting up with the current 
user's Windows directory.    The file specified must exist, but does not have to be a WIN.INI file.

Format: IniClean    /INSTALL
Using the /INSTALL option will have IniClean create an icon in the current user's Program Manager.    
The Quick Install window will pop up, and will allow the user to select a group in which the icon will be 
created.    The default group name will be "Accessories" if it exists.

This option is very useful for network administrators.    When IniClean is properly installed for shared 
use across a network, all of its files are located in one shareable directory.    All that each user then 
needs to do is to run IniClean with the /INSTALL option in order to create an icon in one of their 
Program Manager groups.

Format: IniClean    /INSTALL /GROUP="Group Name"
Example: IniClean    /INSTALL /GROUP="MH Utilities"
Example: IniClean    /INSTALL /GROUP=Accessories
You can add the /GROUP="Group Name" option to specify the default Program Manager group into 
which the IniClean icon will be added.    Note that the double quotes are required if the group name 
contains any spaces;    if the group name is just one word, then the quotes are optional.



Delete an association

To delete an association:
1. Make sure that "Associations" is selected in the "Display" group box.
2. Select the appropriate subset in the "Which ones?" group box.
3. Select the desired association in the list box.
4. Choose the Delete button.

You will be prompted to verify the deletion.    If the selected association is a standard 
Windows association, the prompt will tell you so.    Do not delete standard Windows 
associations unless you are sure that you know what you are doing.

WARNING
All deletions take place immediately after confirmation and cannot be undone!

See also:
View an association



Delete an INI file

To delete an INI file:
1. Make sure that "Other INI files" is selected in the "Display" group box.
2. Select the appropriate subset in the "Which ones?" group box.
3. Select the desired INI file in the list box.
4. Choose the Delete button.

You will be prompted to verify the deletion.    If the selected INI file is a standard 
Windows INI file, the prompt will tell you so.    Do not delete standard Windows INI files 
unless you are sure that you know what you are doing.

WARNING
All deletions take place immediately after confirmation and cannot be undone!

See also:
Changing the "New since" date
View an INI file



Delete a section

To delete a section from WIN.INI:
1. Make sure that "Sections in WIN.INI" is selected in the "Display" group box.
2. Select the appropriate subset in the "Which ones?" group box.
3. Select the desired section in the list box.
4. Choose the Delete button.

You will be prompted to verify the deletion.    If the selected section is a standard 
Windows section, the prompt will tell you so.    Do not delete standard Windows section 
unless you are sure that you know what you are doing.

WARNING
All deletions take place immediately after confirmation and cannot be undone!

To delete a section from another INI file:
1. Change to the directory containing the INI file.
2. Make sure that "Other INI files" is selected in the "Display" group box.
3. Select the appropriate subset in the "Which ones?" group box.
4. Select the desired file in the list box.
5. Choose the Edit button.    A window will appear listing all sections contained within the 

selected INI file.
6. Choose the section which you would like to delete.
7. Choose the Delete button.

You will be prompted to verify the deletion.

WARNING
All deletions take place immediately after confirmation and cannot be undone!

Technical note:
If you delete a section from your WIN.INI file, the WM_WININICHANGE message will be sent to all 
top-level windows.

See also:
Edit a section
View a section



"Display" group box

This group box, located in the main window, is used to tell IniClean what types of settings you would 
like to see listed.

Select one of these values:
Associations
Other INI Files
Sections in WIN.INI

See also:
"Which ones?" group box



Edit a section

To edit a section of WIN.INI:
1. Make sure that "Sections of WIN.INI" is selected in the "Display" group box.
2. Select the appropriate subset in the "Which ones?" group box.
3. Select the desired section in the list box.
4. Choose the Edit button.

The section will be displayed in a popup dialog box.

To edit a section in another INI file:
1. Change to the directory containing the INI file.
2. Make sure that "Other INI files" is selected in the "Display" group box.
3. Select the appropriate subset in the "Which ones?" group box.
4. Select the desired file in the list box.
5. Choose the Edit button.

A window will appear which lists the sections in the specified file.
6. Select a section to edit.
7. Choose the Edit button.

The section will be displayed in a popup dialog box.

Technical note:
If you edit a section of your WIN.INI file, the WM_WININICHANGE message will be sent to all top-level
windows.

See also:
Delete a section
View a section



Extension

Each file name (for example, "TO-DO.TXT") can have an "extension" of up to 3 characters (or 
optionally none) following the period in its name.    For example, the file "TO-DO.TXT" has an 
extension of "TXT."

An extension can be associated with an application so that Windows knows what application created 
the file.



File menu

There are three options on the File menu:

Change directory...
Use this option to select another directory to clean with IniClean.

Return to personal Windows directory...
Use this option to return to your personal Windows directory.    This menu item will only be enabled 
when you are in a directory other than your Windows directory.

Exit
Choose this menu item to exit IniClean.
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Help menu

There are several items on the Help menu:

Current selection
Choosing this option calls up help relevant to what you are currently doing.

Shortcut: Press F1

Index
The Index option calls up this help file and displays the help index.

Glossary
Choosing this option displays the help glossary.

Technical Support
This option displays a help topic which has the telephone number for MicroHelp's technical support.    
This phone number can also be obtained by choosing the About option from the Help menu.

About...
Displays information about IniClean.



INI file

An "INI file" is a text file with an extension of INI.    It is used to store settings that programs need in 
order to operate correctly.    INI files can hold information such as selected screen colors, types of 
printers installed in your system, or customization options for a particular program.

Some examples of common INI files are:    WIN.INI, SYSTEM.INI, and PROGMAN.INI.

WIN.INI and SYSTEM.INI are very important files;    they are like a combination of CONFIG.SYS and 
AUTOEXEC.BAT for the Windows operating environment.



INICLEAN.INI

IniClean saves a list of the known associations and WIN.INI sections for each Windows directory that it
examines.    These lists are stored to a file named INICLEAN.INI in the Windows directory.

The INICLEAN.INI file has the following format:

[Extensions]
; contains a line for each known extension
; note that only the extension is saved, not the associated command line
ABC=
DEF=
XYZ=

[Sections]
; contains a line for each known section of the WIN.INI file in the same directory
Sec1Name=
Sec2Name=



Introduction to IniClean

IniClean is a quick and easy way to keep your WIN.INI file clean, and to perform basic management 
on other INI files in your Windows directory.    IniClean allows you to view and delete the following 
items:

Associations
INI files
Sections

IniClean also allows editing of your WIN.INI file and other INI files;    editing of associations is not 
provided by IniClean.

Why do I need it?
Many Windows programs write some private information into your WIN.INI file.    If you delete one of 
these programs from your system, the extra lines of information remain in your WIN.INI file.    These 
extra lines take up disk space and can cause Windows to run slower.

Most users have unnecessary information in their WIN.INI file.

What's the best way to use IniClean?
The first time that you run IniClean, examine all items (all associations, all INI files, all sections) to find 
and delete any unnecessary items.

Each time you run IniClean subsequently, you can use one of IniClean's special features to list just 
those items which have been created since the last time that you ran IniClean.    To use this feature, 
just choose "New since (date)" in the "Which ones?" group box.    Using this feature, you can quickly 
and easily determine if any additions have been recently made which may impact your Windows 
performance.    This special feature relieves you of checking all of the information in your WIN.INI each 
time you run IniClean;    instead, you can just review the new items.

Is it safe?
Yes, IniClean is very safe.    Before you delete any information, IniClean will always prompt you to 
confirm that you really do want to delete the item.    In addition, IniClean will tell you (in the same 
prompt) if the item that you are going to delete is a standard component of Windows that should not be
deleted.    This prevents you from accidentally deleting a component of Windows that you don't 
recognize but that Windows needs in order to run.



Item

The term "item" is used to mean any one of the following three types:
Association
INI file
Section



Main window

IniClean has one main window which you use to perform most tasks.    From this window, you can 
select the type of items that you want to list, and then view or delete an item.

Main procedure
1. Select an item type in the "Display" group box.
2. Select the subset to be listed in the "Which ones?" group box.
3. Select one of the items listed in the main list box.
4. View, edit, or delete the item.    (Only INI files and sections may be edited.)

See also:
Changing the directory
Changing the "New since" date
Deleting an association
Deleting an INI file
Deleting a section
Editing a section
Viewing an association
Viewing an INI file
Viewing a section



Section

The term "section" refers to a group of lines of text in your WIN.INI file or any other INI file.    Sections 
are often added to INI files when a new program is installed, but they are usually not removed when 
the program is uninstalled.



Section editor

Use this dialog box to edit a section.

WARNING
Do not use this dialog box unless you are sure that you know what you are
doing.    Incorrect modification of sections can cause Windows and other

applications to stop working.

To add a new keyword and value:
1. In the Keyword field, type the new keyword.
2. In the Value field, type the string to be associated with the new keyword.
3. Choose the Write button.

To edit an existing value:
1. Select the desired keyword in the Lines list box.

The keyword and its associated value string will be displayed in the two fields at the 
bottom of the dialog box.

2. Change the string in the Value field.
3. Choose the Write button to write the changes to the section.

If you decide that you don't want to make the change, choose the Undo button.

To edit an existing keyword:
1. Select the desired keyword in the Lines list box.

The keyword and its associated value string will be displayed in the two fields at the 
bottom of the dialog box.

2. Change the string in the Keyword field.
3. Choose the Write button to write the changes to the section.

The new keyword will be written to the section, and the original keyword will remain in 
the section.    If you want to delete the original keyword, select it and then choose the 
Delete button.

To delete an existing keyword:
1. Select the desired keyword in the Lines list box.
2. Choose the Delete button to delete the line from the section.

To delete an existing value but keep the keyword:
1. Select the desired keyword in the Lines list box.

The keyword and its associated value string will be displayed in the two fields at the 
bottom of the dialog box.

2. Erase the string in the Value field.
3. Choose the Write button to write the changes to the section.

If you decide that you don't want to make the change, choose Undo button.



Select a section to edit

Use this window to select a section of an INI file to edit, or to delete a section from an INI file.

To select a section to edit:
1. Select the name of the section which you want to edit.
2. Choose the Edit button.

The section editor window then appears, allowing you to edit the chosen section.

To delete a section:
1. Select the name of the section which you want to delete.
2. Choose the Delete button.

You will be given one chance to confirm the deletion of the chosen section.



Standard associations

The following file extensions are considered to be standard:

Ext Associated application
BMP Paintbrush (PBRUSH.EXE)
CAL Calendar (CALENDAR.EXE)
CLP Clipboard viewer (CLIPBRD.EXE)
CRD Cardfile (CARDFILE.EXE)
HLP Help (WINHELP.EXE)
INI Notepad (NOTEPAD.EXE)
MID Media player (MPLAYER.EXE)    --    MIDI file
MMM Media player (MPLAYER.EXE)    --    Movie file
PCX Paintbrush (PBRUSH.EXE)
REC Macro recorder (RECORDER.EXE)
RMI Media player (MPLAYER.EXE)    --    Sequencer file
TRM Terminal (TERMINAL.EXE)
TXT Notepad (NOTEPAD.EXE)
WAV Sound recorder (SOUNDREC.EXE)    --    Waveform audio file
WRI Write (WRITE.EXE)

IniClean does not verify that a standard extension is actually associated to the standard application.

See also:
Standard INI files
Standard sections



Standard INI files

The following INI files are considered to be standard:

File Used by
ATM.INI Adobe Type Manager
CLOCK.INI Clock (CLOCK.EXE)
CONTROL.INI Control Panel (CONTROL.EXE)
DOSAPP.INI DOS applications settings (Windows 3.1)
INICLEAN.INI IniClean (INICLEAN.EXE)
MOUSE.INI Mouse settings
MPLAYER.INI Media Player (MPLAYER.EXE)
MSD.INI Microsoft Diagnostics (MSD.EXE)
NDW.INI Norton Desktop for Windows (NDW.EXE)
PENWIN.INI Pen Windows
PROGMAN.INI Program Manager (PROGMAN.EXE)
SYSTEM.INI System & boot-up configuration
WIN.INI System configuration
WINFILE.INI File Manager (WINFILE.EXE)
WINMINE.INI Minesweeper game (Windows 3.1) (WINMINE.EXE)

See also:
Standard associations
Standard sections



Standard WIN.INI sections

The following sections of the WIN.INI file are considered to be standard:

Section Used by
Cardfile Cardfile (CARDFILE.EXE)
Clock Clock (CLOCK.EXE) (Windows 3.0)
Colors Windows
Compatibility Windows 3.1
Desktop Windows
Devices Windows
Display driver Pen Windows
Embedding Windows (Object Linking & Embedding [OLE] information)
Extensions Windows
Fonts Windows
FontSubstitutes Windows
Intl Windows
MCI extensions Windows
MCI.* Windows
MSCharMap Character map (CHARMAP.EXE)
MSWrite Write (WRITE.EXE)
Network Network
Networks Network
OldFonts Windows
Paintbrush Paintbrush (PBRUSH.EXE)
Ports Windows
PrinterPorts Windows
Programs Windows 3.1
RegEdit Registration Editor (REGEDIT.EXE)
Solitaire Solitaire (SOL.EXE)
Sounds Windows
Spooler Print Manager (PRINTMAN.EXE)
Terminal Terminal (TERMINAL.EXE)
TrueType Windows
Windows Help Windows Help (WINHELP.EXE)
Windows Windows

Note that not all of these sections are required for proper operation of every system.

See also:
Standard associations
Standard INI files



Technical Information

Command line options
INICLEAN.INI
List of standard Windows associations
List of standard Windows INI files
List of standard Windows WIN.INI sections
Technical support phone number
WM_WININICHANGE message



View an association

To view an association:
1. Make sure that "Associations" is selected in the "Display" group box.
2. Select the appropriate subset in the "Which ones?" group box.
3. Select the desired association in the list box.
4. Choose the View button.

The association will be displayed in a popup dialog box.

See also:
Delete an association



View an INI file

To view an INI file:
1. Make sure that "Other INI files" is selected in the "Display" group box.
2. Select the appropriate subset in the "Which ones?" group box.
3. Select the desired INI file in the list box.
4. Choose the View button.

The INI file will be displayed in a popup dialog box.

See also:
Changing the "New since" date
Delete an INI file



View a section

To view a section of WIN.INI:
1. Make sure that "Sections" is selected in the "Display" group box.
2. Select the appropriate subset in the "Which ones?" group box.
3. Select the desired section in the list box.
4. Choose the View button.

The section will be displayed in a popup dialog box.

To view a section of another INI file:
1. Change to the directory containing the INI file.
2. Make sure that "Other INI files" is selected in the "Display" group box.
3. Select the appropriate subset in the "Which ones?" group box.
4. Select the desired file in the list box.
4. Choose the View button to display the entire INI file at once, or choose the Edit button 

to use the section editor to view the section.

See also:
Delete a section
Edit a section



Viewer

The viewer dialog box is used to display the contents of an INI file or WIN.INI section.

To close the viewer:
1. Choose the Close button.

To copy the contents of the viewer to the clipboard:
1. Select the desired text in the Contents box of the viewer.
2. Press CTRL+INSERT to copy the selected text to the clipboard.    If you are running 

Windows version 3.1 or later, you may also press CTRL+C to copy the text to the 
clipboard.

After copying text to the clipboard you may wish to switch to another application to paste the data.

Note:
You may edit the contents of the Viewer, but the changes will not be written to the INI file or WIN.INI 
section.



"Which ones?" group box

Once you have used the "Display" group box to select the type of settings that you would like to see 
listed, use this group box to tell IniClean how many of the selected type you would like to see listed.    
This group box allows you to list all, or just some, of the selected settings.

Select one of these values:

All
This is the full set (all items).

New since date
This lists only those items which have been created since the last time IniClean was run.    This option 
is very useful when you are running IniClean just after you have finished installing a new program 
because it will show you what new items the program created when it was installed.    The "New since" 
date can be changed when you are listing INI files.

Non-standard
This lists only those items which are not a standard part of Windows.

"Items" are associations, INI files, or sections.

See also:
"Display" group box



WIN.INI file

The WIN.INI file is a very important file which every Windows user has in their Windows directory.    
WIN.INI and a companion file (SYSTEM.INI) are like CONFIG.SYS and AUTOEXEC.BAT for Windows.

WIN.INI contains important settings which control how Windows works.    Many other programs also 
put settings into WIN.INI.

You should always be very careful when changing the WIN.INI;    improper settings can cause 
Windows (or other applications) to work improperly.



WM_WININICHANGE

Note:
This information is provided for advanced technical users.

The WM_WININICHANGE message will be sent to all top-level windows if you edit or delete a section 
of your own WIN.INI file.    It will not be sent if you are editing a different WIN.INI file.


